Welcome to the DYNAmore Express Webinar!

The session will start soon.

Please make sure to mute your microphone.
Feel free to post questions in the chat and we will answer them at the end.

No part of this broadcast may be reproduced, distributed, or transmitted in any form or by
any means, including photocopying, recording, or other electronic or mechanical methods.
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m LS-PrePost Version Overview

m Recent Developments
Pre-processing
Post-processing
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LS-PrePost - The Team
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m Closed and fruitful collaboration with LS-PrePost developers since many years.

m Do not hesitate to contact us for suggest
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LS-PrePost - Version Overview

m LS-PrePost is delivered free with LS-DYNA.
m LS-PrePost download area for the DYNAmore clients: https://fileshare.dynamore.de

LS-PrePost is developed for ... - Windows I LS-PrePost-4.9-x64-27Jan2022_setup.exe :

- Linux (= Common version)

- Mac OS ! LS-PrePost-4.9-14Jan2022.dmg |

m Special versions are also available e.g. DP (double precision) and GTK3 development version.

m Current release version: 4.8 Python Scripting possible since 4.8!

m Development Version: 4.9 (Dev)
Official release expected for March 2022
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Mesh - EleGen (Element Generation)
m Extent functions of Mesh>E(Gen 2Solid 2Solid By: Shell_Thickness

Element Generation *

Transfer the stress and strain (*INITIAL_xxx) from shell to solid when doing. OBeam  Oshel | @ sold

Create *CONSTRAINED_ADAPTIVITY in solid part when creating solid by e | [0
Shell_Thickness and the selected shell elements uses *CONSTRAINED_ADAPTIVITY part I: Opick P ShapeM RefGeo
Newip) | @ 9 f
Dz:ne;fw o Mew NID AutoM  Curve
Solid By:|sheII_Thickness v| ﬁ &
@ Average SolidM Surf
:> ) Max . %
O in BlockM  Solid
segment| 22 Ly rP
[]Deleteshell MLineM  GeaTol

[ Create tshell element Eﬁ
2DMesh ﬁ
A a3
m Can now create cohesive elements in-between creste || Reect || Accept TE;” Model
. . . - * i
tshell elements in ElGen 2Solid >Cohesive . it 0
W
13 s 99 . . . . EleﬁEﬂ ME
m Add “Ratio” option in Solid by >Shell sweep 2By line p ™
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\n sys LST All rights reserved. Non-commercial usage is granted if credits are given clearly to DYNAmore GmbH and copyrig%?,rr;%n;rks are not brg?(re%o?ed. 9 :I2¥ N A



EleTol (Element Tools) 2 EleEdit (Element Editing)

m Create the transition element between m Enhancement of the solid element quality
adaptive mesh and regular mesh check

Option “Show failed only”
After user put in a criteria, the element below

that values can be seen by showing other
l:{> element with wireframe mode

(@ Check | () Split/Merge
O Modify

(O Delete (O Direction
(O Composite () Align

Lrfse L o [ show Free Edges
i OCheck i fffféé = Beam (® Solid
(O Create (®) Modify Transf Méh Shell Tshel
sl -
(O Delete Tecaan <[> - Checking metilwd
; ) ==, Minimurm Angle A
() Composite () Align j Maximum Angle
Mode| Distortion Index
[ Show Free Edges — Volume
(®) Thickness () Offset oy Erf;";?ggammed
(OBm3nd  (JRing Mesh EleTal Char langth v
Be _ ;
(O Uniform Thickness to Shel & | Show failed only
) ) Duphod
(O Mon-Uniform Thickness to Shell i Post Lessthan ~ .88
O TwoTria i Solid Rev | Check | Save Failed
(®) TransAdapt ModEdit Ms
&E M5 Done
e |
EleEdit | (¥
ﬁ\ MdChk
Apply Reject || Accept B
o - o | Measur h:tj
Daone Eals Favrri
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EleTol (Element Tools) =2 Transf (Transform)

() Transform () Reflect
. ® Translate () Project
m New options for transform (=copy) nodes to a new Part ID ORotate Oscle
Support keep part property (MAT-ID, Section-ID, HG-ID) e
. Translate Model
Support set part title when copy element [TFres Edt
Direction: X v
Distance:| 100 |
(® Global O Local
Coord Sys
Tran - Tran +

—= i“”‘;" am AT
% . . . EDE: E:wt'rty [ Keep Property
m  The ,,Copy Entity“ option is to copy also the *INITIAL cards Mo of coples:| |

of the elements, e.g. symmetric LS-DYNA runs can be reflect in LS-PrePost to | 27« 2|[pet

Part  Title: ball2
a full model with all results. (Deactivate at first in Settings> Configuration Starting E1>: 425
Settings > Keyword > “Save initinfo to temporary file” to import really all i i
INITIAL cards and not only the included values to the FringeComp interface). Reject || Accept || Done
C ight 2022, DYNA GmbH
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EleTol (Element Tools) 2 Find

m Highlight attached elements for found node

LS-DYNA keyword deck by LS-Prepost
ime = 10

Time

Bin- 0. 010070, at elemd 248
1 max=0.0938539, at elemf 227

Find >
| (® Node ‘ (O Element
OpPart () CNRB
@ Any Solid
Beam Tshell
(O Shell Sphnode
Nurbs DiscSph.
[CJcnrB
(O Show Only (@ Highlight
[ show Attached Eid
Nd/E//Part ID: | 10000109 |
No.Neighbor: | p | |
UnblankAll ' UnblankPart

Find :Neighbors Done

EleTol (Element Tools) 2 Identify (Ident)

[ |
= Post = FringeComp: Max
» ldent 2 Element = “Show Results”

5

§ *
?@ § :‘wm

fR i ST

g
)
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63

. 0O
w7

=
g

|

. [ [ S5

§: fmic

m Print integration point info in case the max option is active
Necessary settings for this option:
= View - Results On Screen
Post 2 FringeRange - AVG: “None”

Frin ~

Max

T —
ot 2

d3_p|0L| Set shell stress surface position and int. point |

Done

View Geometry FEM  Application

Full Screen (Esc to Exit)

Background
Geometry Shade
Element Shade

All Elements
All Geometry
Ref Geometry
Points
Curves
Surfaces

Grid
Toolbar

Local Element Axes

Beam Prism

Beamn Prism Fast

Smeoth Fringe Color

Keep Zout Orientation

Show Deleted Nodes

Show Deleted Elements
Show Deleted Elements Only

. Results On Screen

Smeoth Shade
Record Message
Show Mid-Side Nodes

A Avic Nrientation Onlhe

ings
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Beam visualization

m Beam prism visualization for *INTEGRATION_BEAM has been revamped, showing the proper geometry
Various enhancements: *ELEMENT_BEAM_OFFSET/ORIENTATION well represented

L5-PrePost(R) V4.9 (Beta) - 141an2022
File Misc.  View Geometry FEM Application Settings Help
Full Screen (Esc to Exit)

Background ¥
Geometry Shade ¥
Elernent Shade >

~  All Elements
~  All Geometry

Ref Geometry ¥
+~  Points

Curves ¥
~  Surfaces

Grid

Toolbar ¥

Local Element Axes
[V BeamPrism
Beam Prism Fast
Smooth Fringe Color
Keep Zout Orientation
Show Deleted Nodes
Show Deleted Elements
Show Deleted Elements Only
Ignore Deleted Elements Flag
+~  Results On Screen
Smooth Shade

Courtesy of Gexcon France

For faster rendering of models with many elements try next option “Beam Prism Fast”:
<\ The beam will be drawn as line until stop rotating and the final picture will be beam prism.

Copyright 2022, DYNAmore GmbH r ‘(
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Model > Section Plane/Cut L

—
m Add section cut function for beam elements l

LS

U

VS

m Shell thickness, tshell and solid elements is now supported to write option:

Model Section cut

.iges

N [

Section Plane -
(@) Fix5 () FixM (O Laar
® 1p+NL (O N1-N2
(O 3Nds () 2Nds+D

Options:

ShowP| []300utline

[ 5hMesh 5.705909

[15how Edae

Line Width: 2 v

Line Color: Partcolor

[ Color/Cut Thickness

VP: Mone =~ X (] £

m Coming soon: Beam “Write” output in section cut interface.

Modify easy the cutting plane position by moving with pressed
mouse on the cutting coordinate since LS-PrePost version 4.8.

¢S

PartD Solid

CE -

Display GeoTol

ik
vel g
RefChk @

Const Mesh
Renum
Iges « |State: El L_':j
Add Cut || Write || Current Renum A
[wnee ] " 1 Model
Move Plane {3 g
Base Pt. Location: ' ZE:‘E'*
Section
| 200.0001(| 150.753¢| -696.030| EleTol
43
=) =

Mo. of CL ~ Upd Bspt

4= | MP Anim |« | Cr Kpsc

[IKeep Cuts Clear

Project View | [Sect Fringe
[]sect Vector

Off ~ []Keep Section

Cut Options Crush

Model Meas Line

Farce Save Done
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Isogeometric Analysis = IGA

m Create shell/volume element in new IGA format (*IGA_...)

Geometry | Shell IGA |

Editing element (e.g. refinement) works with new format
m Trimmed solid is now supported

m  Model generation for NURBS shells and NURBS solids possible
@ @ 3

Mesh Murbs Murbs3D

Keywaord Manager bt : i
Keyword Edit Keyword Search %
SelPart  RefGeo
Edit:| PART V[ EdE |
@ Model (O Al RefBy U

MName Count Curve
=16A 513 -E <7
w1 D_BREP 3 CreEnt  Surf

- 1D_NURBS_UVWY 148

v 20 NURBS_KYZ 33

e EDGE_UNW 148

- EDNGE_XYZ a4

e EACE_KYZ 33

- GHELL 33

- TIED_EDGE_TO_EDGE 1
[-NODE e
m 1

Material arrange

GroupBy Sort List:

Model ~ | Type <Al -

Load From MatDB
Keywaord Del ResForm
| ExpandAl | | ColapseAl
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Model >CreEnt (Entity Creation)

m Improve “Show” option by assign different color per & Vv

Keywrd Curve

* * e
LOAD_... and per *BOUNDARY_SPC ity Crai x = &
. - Airbag @ Show §O)Cre (O Mod (O Del =
E.g. ’ 4 *LOAD SEGMENT are def'lned " ShelRefGM _ CreEnt | Surf
gz &- Application Label: | None e @ Q
Esﬁgtd;::ed All None Rev AList E |
- Contact PartD  Solid
g barong Y
i Elzf;: :nt DisElIay GeoTol
- Initial = Ty,
i Integmtion v tfé
= Load RefChk
Node Fenum MESI"I
- Rigid Bod I =
L gﬁéllgiﬂeﬁ Sat) Renum Mcd_el
(- Rigidwrall
: ! s
- Sect i gea-g
-- S:t I;:lljalla S:ﬁn ::‘ﬁr
EleTol
Done Ay

m Visualization with arrows of load direction in *BOUNDARY_PRESCRIBED_MOTION
Animation of a prescribed motion keyword under Display Entity possible:

w Entity Display x

,ﬁ - | [ Entity Display | Entity Preview :>
Model [ o R
——

Copyright 2022, DYNAmore GmbH rDY N A
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Model >CreEnt (Entity Creation)

m Support create circle plane via entity creation
dialog (*DATABASE_CROSS_SECTION_PLANE)
If radius is greater than 0.0, the plane is

created by the radius and coordinates of two
points(head and tail)

If radius is less than 0.0, it will be created from
two nodes(NID1 and NID2)

Entity Creation *
- Airbag (O Show @ Cre OMod () Del
- ShelRefGM
- Application @ Plane Oset
& Boundary Label: [None ~
- Constrained
[#- Contact ) s
& Damping Pick XV Yv v
) Database O | I [ |
sy
| - Cross Section | LENL| 0.0 |
-~ Cpm Sensor LENM| 0.0 |
- Define
[+ Element I Radius| 50 I |
[ Initial Title |
[#- Integration
B Load €S| 1 |rTveE[o |
(- Rigidwall
= Sacton PsID | || crepse |
<| B Set Data @ 1n+NL (O N1-N2 () 3Nds
Gen (O Tran (O Rota
(ORefl [ Geometry
X Y Z
I?H Bl | 0

m Create discrete sphere element via entity
creation dialog

Entity Creation

(- Airbag

w- ShelRefGM
- Application
- Boundary
- Constrained
- Contact
[#- Damping
=)~ Database
- History
- Cross Section
- Cpm Sensor
- Define
- Elernent

i =}
I - Discrete Sphere I

- Seatbel Accelerometer

(- Initial

- Integration
- Load

[+- Rigidwall
- Section
- Set Data

(O Show @ Cre (O Mod O Del

Label: None w

Ovolume
Overwrite existing

PD: |3 | mew |||

Mass: |88 |
Inertia: |55 |
Radius: | .31 |

Apply Cancel
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View = Solution Explorer - Structure

m It provides the complete model tree view,
visualization of the tree items, error
checking before run, and of course the Shructure
automatic keyword output e

Thermal
Structured ALE
ISPH

EM

[ | Structure: Create Cancel
In “Explicit Dynamics”, the “time step” settings are supported.

Add some new objects like “General Contact”, “Deform2Deform”, “Rigid
Merge”, “Unreferenced Part” etc.

Add inertia data in the property of part objects which will lead to
“_INERTIA” option in *PART keyword

Replace the old icons with some new icons and change the font size of

Case Type:

Solution Explorer

=)+l Multiphysics Solution

= I ™ Case_1

I8 Structure

#Q Analysis
#o® Mechanical Analysis
=I-+le Explict Dynamics

At Time Step

#i8 Model
’® Parts

#f Shell Parts
¥v»# Blank
=-¥v# 3u02-DynaSimDemo-Ps2u-02
@ Body Constraint
*73) Prescribed Motions
#» Prescribed Motions-1
=--&v# 3002-DynaSimDemo-Ps20-02
¢ Body Constraint
=-Nv# Ger3
#@ Body Constraint

=+ Unreferenced Parts

¥ Gerl

#@ Body Constraint
vive Ger2

7@ Body Constraint
=-Nv® Gerd

#@ Body Constraint

#+s Initial Conditions
=i Prestress

+--+#¢» Boundary Conditions
#%. Contacts

B
(7 Assembly 1
L5 ) FEM Parts
Keyword Entity
Boundary
Constrained
Contact

Define
Set

tree items o
A new object called “Unsupported Keywords” is added to show some mmm” o
significant unsupported keywords in current tree structure T _
Support to get correct “PreStress” property data from keyword file . <
Add “Keyword Preview” at the root tree item menu . T oo
Solution X ‘>
\I‘I SYS LST rights reserved. Non-commercial usage is granted if credits are given clearly to DYNAmore GmbH and copyricg,%?yrreiﬁ?;rigézr)eI?LT?JZ%em%vmebdl_.l rDY NLA
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View =2 Solution Explorer 2 EM o

Thermal
Structured ALE
ISPH

s EM

The “EM” module is added to solve the problems about electromagnetism. Users can load an executable
keyword file and FEM data (parts, elements, nodes) by using the “Structure” module coupling the “EM” module

Case Type:

M LS-PrePost(R) V4.9 (Beta) - 03Dec2021-64bit C:\TestData\EM\TestExample\DC mottor\ik

Support to do following analysis g Seom (B doplcsion sester 1 iy

] X

k‘-§&$’z 2
£

#%. Contacts-1
#% Contacts-2
=& Permanent_Magnets

/I Permanent_Magnets-1

lns i

= Eddy Current [ @V

= Inductive Heating E 5“ g

= Resistance Heating E; G:Z,,

Do the coupling analysis of “Structure” 'f‘}_:

and “EM”. And the FEM data and & £

mechanical settings like initial o s

conditions, boundary conditions, e oy

connectors and contacts between the il =
FEM parts should be built in the L s %
“Structure” module [ o
3t

wm * 'O‘M’t —— = I O%on g %b, n;?h Sgk Soa‘;do F?ge. E?Goo. Un:d ke ShiCtr Cl]urAntCnZ;ln z;[%nn?n VCrd Iop Angle Rot:( > P?sp Home '\'
“TEAM 3" problem, "Rail gun” problem and "D.C Electric motor” can pass the test by using this “EM” module
Copyright 2022, DYNAmore GmbH r ‘(
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View 2 Solution Explorer 2 ICFD

m ICFD
Add the unit for "velocity”

#%§ Model
% Parts

,

,
,

AU R

Add prescribed turbulence condition
Add initial turbulence condition
Add -X,-Y,-Z in Load Body->"Options*

P

B Surface Part](Inflow)

@ Surface P

7 Surface P,
7 Surface P
/¥ Pan O
£ Mesh |

W)+ Volume P

#Z Load
# @ Mesh
#7 Output

Materiall

Body

Initial Condition

Thermal Boundan

Lagrangian Properties

Mesh Properties

Output

Wave Generation
(rmses]

Model
/% Parts
= Wiv* & Surface Part1(inflow)
drescribed Turbulence )
'
Wiv* & Surface Part2(Outflow)
Wiv* & Surface Part3(Symmetric)
Wi & Surface Partd(Wall)
# 1 Part Output
# 1§ Mesh Properties
W+ S Volume Part5

ICFD Partially submerged pillar
L]

Time =

Ve Wall_Stator(Wall)
~*» Mesh Properties
Vivrwe +Z(Symmetric)
~* Mesh Properties
Vivrwe -Z(Symmetric)
~w Mesh Properties
Viwrwe Wall_Rotor(Wall)
~w Mesh Properties
&) Volume PartS

~¥ Mesh
~, Output ~
FProperty Explorer
Material Water 1
Angular Velocity
Value Type ~

Variable Type Turbulence kinetic energy

Method | Direct imposition through value specified by LCID
7 Defined By Load Curve
Curve 0,26.4

4 Variable Type Turbulence dissipation rate
Imposition Method  Using turbulence intensity specified by LCID

Reset Object Type #% Load Bodv Defined By Define Function
Delete Function fixy,2)
*ICFD_BOUNDARY PRESCRIBED VEL
T B 2 EEREE 2 1.0 01.00000E28 0.0
*ICFD_BOUNDARY PRESCRIBED VEL
IR B 3 ERERS | 2 1.0 01.00000E28 0.0
*ICFD_BOUNDARY PRESCRIBED TURBULENCE
1 1 0 ] 0.0 0.0
1 2 1 4 0.0 0.0
¥ITFD_BOURDARY PRESCRIEED PRE
T2 0 5 ~ 1.01.00000E28 0.0
*ICFD_CONTROL_TIME
100.0 0.0 1.0 0 0.0 0.0 0.01.00000E28

=}« Huid
#- (s Analysis
¥+ B Materials
= v Global Imposed Move
= Global Initial Conditions

Non Inertial Reference Frame
Wave Damper
Initial Free Surface
Initial Turbulence

¥« Volume Part5
7= Load Body
@ Mesh
+ 1, Output

Levelzet_16
Fluid pressure
2.000e+04 _

L770e+04
L.540m+04 |
1L310e+04
L.080e+04
B.5008+03
£.2008+03
2.9008+03
1.6002+03
=7.0008+02
-3.0008+03 |

=) %5 Model
=+ Parts
Wiv & Surface Part11(Inflow)
7™ Prescribed Turbulence
Wl & Surface Part2(Outflow)
Wi & Surface Part3(Symmetric)
v & Surface Part4(Wall)
¥ Part Output
+*[¥. Mesh Properties
W)+ Volume Part5

/" Load B
— i Inmal Turhu\ence
@ Mesh
7, Output
Explorer
Define Kinetic energy by Value
Kinetic energy 0)

Define Dissipation rate by Value

Dissipation rate 0
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Contours of ForChain
Fringe Levels

min=0, at node# 5098
Max=63.4491, a¢ node# 12048 /"—\
N
> 3.000e+00
2.700e+00
2.400e+00 R
2.100e+00 i}

1.800e+00
1.500e+00
1.200e+00
9.000e-01
6.000e-01
3.000e-01
0.000e+00 2l
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Fringe Plot Options

Main menu “Settings” 2> “General Settings”:

m Add of “Fringe Scale Factor”
Multiply and Divide

g - Effective Stress (v-m)
() SPH/Particle
(") Discrete Sphere Element 1.0
() Thickness Scale Factor 0.9
I@ Fringe Scale Factor I .
(_) Local Coord System 0.8 _
Fringe Scale Factor
O Multiply @ Divide 0.7 _
565.245 || 1.0 w 0_6 |
0.5
"
0.3
0.2
Apply Clear
Daone 0.1
0.0

Post 2 FringComp (Fringe Component) > Stress:

m Add of Component “Signed Von Mises Stress”
(in Post =2 History interface too)

Hdv
Result
Strain

Misc
Elastic

Beam

s

X-stress

y-stress

z-stress

Ky-stress

yz-stress

T-stress

effactive plastic strain
pressure

Von Mises stress
1st-prin dev stress
2nd-prin dev stress
3rd-prin dev stress
Tresca (max shear stress)

£ 1st-principal stress
DES 2nd-principal stress
3rd-principal stress
Forming | | max in-plane stress
AL —
FLD Signed Von Mises stress
User
LSDA
I - |
Apply | fintpt 2
Frin  ~||ntpt 3
intpt 4
Max  ~||intpt 5
intpt 6
d3plot ~||intpe 7 v
Done

Signed VonMises stress
538.2
427.8 :I
317.5 _
2071 _

96.8 _
-13.5

-123.9 ]

-234.2

-344.6

-454.9

-565.2 _|
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Fringe Plot Options

Post 2 FringComp (Fringe Component)

m Iso-surface: support TSHELL
m Fringe now recognizes *INITIAL_TEMPERATURE

in LS-DYNA keyword input decks
m Fringe Strain: Reduced components

Stress

Ndwv

Lower Ipt z-strain
| ower Ipt xy-strain
Strain Lower Ipt yz-strain
Lower Ipt zx-strain

DES
Forming
ALD
User

LSDA

Apply
Frin v
Max

d3plot ~

Lower Ipt plastic strain ~
Upper Ipt plastic strain

Lower Ipt x-strain

Lower Ipt y-strain

Lower Ipt max-prin. strain
Lower Ipt 2nd-prin. strain
Lower Ipt min-prin. strain
Lower Ipt effective strain
Upper Ipt x-strain
Upper Ipt y-strain
Upper Ipt z-strain
Upper Ipt xy-strain
Upper Ipt yz-strain
Upper Ipt zx-strain
Upper Ipt max-prin. strain
Upper Ipt 2nd-prin. strain
Upper Ipt min-prin. strain
Upper Ipt effective strain
Mean Ipt x-strain
Mean Ipt y-strain

Mean Ipt z-strain W
< >
intpe 1|
intpt 2
intpt 3

Done

Stress Lower Ipt plastic stra
Upper Ipt plastic stra
Mdv x-strain
Bocyl :::ttslllq
Strain W'Stm.'”
yz-strain
Misc ¢-strain
max-principal strain
Elastic | | 2nd-principal strain
min-principal strain
Bea effective strain(v-m)
pH Tresca (rmax shear st
& max prin strain(X-dirc
DES max prin strain(Y-dirc
max prin strain(Z-dirc
Forming | | min prin strain(X-dirce
min prin strain(Y-dirc
FLD min prin strain(Z-dirc
User
LSDA
< >
fintpt 1|
Apply intpt 2
Frin | |intpt 3
Max v
d3plot ~
Done

5

nsid
1

temp
293.15

temperature

293.15 _
263.83

*INITIAL TEMPERATURE SET [EEEREE

205.20
175.89
146.57
117.26

87.94

58.63 |

29.31 _
0.00 _
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Fringe plot

m Fringe plot the shortest distance between two groups of segments in EleTol 2 Measure

Item:| Dist Segm to Segm

Thickness Active Elernents Only
1.51 Airbag Mode RG
1.49 Elermn (_'Part (Al ) Seg (_INd
147 Connected segment(s) only
1.45 Reference Axes: Delete
1.43 Global 7
141 Nodedit M
MS
140 _ Cancel Pick Apphy Report &E 3
R EleEdit
138_ Segments to Segments = Mﬁk
1.36 ® Group 1 () Group 2 e,
RED Meamd 1}
sh Favorl
1.32_ ow Esh
Done M h

m Fringe plotting of solid thickness and %thickness reduction if *DEFINE_FORMING_SOLID_SURFACE is
present to define the two opposite sides of the solid

Copyright 2022, DYNAmore GmbH r ‘(
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Resultant vector in intfor

Post = Vector = Force Resultant

m Resultant force vector is now implemented
A yellow resultant force arrow is computed from the currently visible force vectors in an “intfor” file

The resultant value and its components are written to the message dialog when the checkbox is toggled ON

n

s
]

Force v T - ﬁt{f
Total Element Force Vectors — EleTol
Nod El
2253 e ice =
20.27 LA A stte | po
- Vector Range Post
18.02 _ e = ED
15.77 = Partide Ms
- Max: 0 - MS
13.52 zﬂ "
11.26 g Dyemic 8 S Chaivd /4
User Show
9.01_ 3\) MdChk
SF: [1.0 ¥ ouput 3
[JHidden line vector off ' Favorl
[IKeep vector display v
s Vector
[C] Apply settings in Range v
) d node vel.
[ Force resultant '
Prin. int.pt.
None v
O Whole @ Part
O Area O El/Node
D 5 @ %0 2 ‘ E b o % =a Apply Clear
Ve AW 15 @ %
5 Save Done
resultant = 2028.288574 (0.064523, 0.460880, -2028.288523)
Copyright 2022, DYNAmore GmbH r ‘(
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ALE/S-ALE - EleTol 2Measure

m Support measure points of S-ALE mesh box
Model - Display Entity: “S-ALE mesh box” in Entity Display dialog first
Then select method item “Dist SALE Points” of the EleTol-> Measure dialog:

Measure *

Item: Dist SALE Points |

Entity Display

Entity Display  Entity Preview

[ A

|| MNaone

Active Elernents Only
Airbag Mode RG

Elem Part Al () Seq Nd
Connected segment(s) only

Reference Axes:

- Initial
[ Set

Global

Entity Selection

| Al || none | Rev || Aust |

Label None -

Cancel Pick Apply Report

— History

X-coordinate
Y-coordinate
Z-coordinate
Magnitude

Done

m Interface force file: dynamic fringe label for special SPH, ALE

| pot || mew || Padd |
| Clear || Raise || Pop |

Transf

rans r—f:
Mormal
s

DetEle

LR ]
Duphod

o

NodEdit M
2 g

EleEdit

MdChk
.
% Fawvarl
M h

\n sys LST All rights reserved. Non-commercial usage is granted if credits are given clearly to DYNAmore GmbH and copyr

Copyright 2022, DYNAmore GmbH
ight remarks are not be removed.

fbvna

26 MIORE



EleTol=> Measure

m Output of tributary area is now supported in the message box:

---------------------------------------------------- FtiFal
! ]
g Sihit
L :(ﬁ @ - U'*‘ ﬁ - @ :31'.’ ,. E o
I- -——T-= jectMo  Fringe Unref  |EdgGeo| ShaGeo WirGeo  ShfCtr  Clear AutCen Zoln EdgFd
I : B oy area is 5.6205 R »
1 . ]
| ° e s [ttt -
1
|
1
1 3 .
L A ¥ Y
( Item: | Area w Tr?nsf Mesh
[ Active Elements Only (} C:
Airbag Node RG Mormal Mod_el
O Elem O Part O Al O Seq @ Nd Z ]
: —_———— -I I_ —— Scale Factor: Dee E:‘I"::I
! | ! OTMECLEl CeaTeEnae) onTy - @J
@ 4 - 2 J Reference Axes: Delete E=
B Post
Global *
NodEdit M
Cancel Pick Apply Report &% MS
— Hist ;
d deedt Qf
Area
change in area % MdChlk
EE” Fawvorl
m Scale factor for mass, area and volume v
Plot New Padd
Clear Raise Pop
Done
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History Variable#5

SPH fringe and SPH Post Output e —
572 Ndv g}l{:;ﬂltticknessd "
. . . — - 545 Resuft h_nurlgclaz;]Sesprt;argL;r o
m Support fringe for history variable e e il ey
] “a90 I || e parameter {2-sg2-
ERstic | | lode parameter-att (27/2]
462 _ strain energy density
Nl | e
" .380— Forming h:::ttgg:g:;ﬁ
362 _ AD | nitory varee v
325— Lzer < ’
0 Shell Thickness
2? ] LSDA Thickness Strain -
242: Pick
Thick: 0.0
215_
[
£ > 188 _ —
i SN 160 Fin__v] ™0t =
m Post .. - Output .~ S e
Output SPH surface to STL 105 —
78 - Done
Support SPH mass output ol
Losersie e s oo Post - Output tool is very useful for example (FAQ in support):
00000 0 .2000e-07 .
1000002 101 4.2000e-07 Output the *NODE coordinates of the last animation d3plot state
1000003 101 4.2000e-07
1000004 101 4.2000e-07 Output of the current strains and stresses in LS-DYNA keyword cards
St I *INITIAL to use the initial values for follow-on simulation (DYNAIN)
1000007 101 4.2000e-07 Output of the current fringed element or nodal values and re-import with
the FringeComp>User
Copyright 2022, DYNAmore GmbH r ‘(
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Post = Trace and Streamline

Trace and Streamline X

(O Node Trace () Streamiine
O Point Trace ) Part Trace

m Add a Flow Curve tracing tool

CG Trace Curve Trace
(® Flow Curve
Flow Curve Ef @
Pick Solid Part :l Bnout
oy

Create Mode Foﬁv i
Model

Plane Curve —
. ‘e EP
Pick Origin Point Tace ]
Set Normal X OI

: e | o)

Swap U/V | Cut View e

Particle Ms
Apply

Curve Lists Single Selection

Rev All Del
Configuration
Flow Curve |3 ~ -

Num Lines Tessellate

[]show Points [] Transparent
Show

Done

Copyright 2022, DYNAmore GmbH rDY N A
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View =2 Ignore Deleted Elements Flag

m Since 2021 a new option is added in LS-DYNA to write results to d3plot/d3part for deleted elements
m In LS-PrePost the option “Ignore Deleted Elements Flag” ignores element deletion information:

View

Full Screen (Esc to Exit)

Background
Geometry Shade
Element Shade

All Elements
All Geometry
Ref Geometry
Points

Curves
Surfaces

Grid

Toolbar

Local Element Axes
Beam Prism

Beam Prism Fast
Smoaoth Fringe Color
Keep Zout Orientation
Show Deleted Modes
Show Deleted Elements

Show Deleted Elements Only

Geometry FEM Applicatic

Ignore Deleted Elements Flag

™ To—

Ignore Deleted
Elements Flag: OFF

Ignore Deleted
Elements Flag: ON

Plastic strain [-] (E-03)

Element History from d3plot

_A_Flag OFF
_B Flag ON

B . AR a@ S T . —

10 15 20

Time [ms]
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Post 2ASCII/BINOUT/MS-ASCII

m Binout interface

| O spH/Particle
(O Discrete Sphere Element

NodFor: Apply local CS to Force P e 1o A xoai@om 20t uesy |
. . : : o C Ylowi @ o201 (UCSA) | e
Support for derived strain components, like max, min lowse ome | o ° S
. . . . . | T E 6 =
principal strain, effective strain ] $. ] ki
Support for searching part id in “matsum” branch oo Ou O : 4

Import Unset

.| B PlotWindow-1

Cl

12 m24

Component@ Node/Group ID

iac

flodfor Branch

v 5
— R - e e e e e e e e e

|
|
|
|
Support for bndout branch’s "set id" feature o =] ° Bt e | ks
: = 2 0 0.5 1 1.5 2 F::.T:
1 Time Reviod 1
1 | Title I Seale | Attr [ Filter ’ Print I Save I Load ’ Oper ’ Hide I Close | Quit None 1
: [eow ] )
: t L
m ASCll interface - oo |
________________________________ rgauinr el o e 1l
Support for the eloutdet node global strain of ASCII reader
Support for the dem pattern post processing e ;
I Selection by Selection by one I
: ID range: or multiple IDs: !
| |
' Matsum Branch| Q, 2:5 Matsum Branch| Q, 2, 5 !
m  MS-ASCII ! K : = " !
Al
- - ! R
Support for new component of icfd_point. | — vone | !
. . | 4 1
Support for plotting xy-data from em_magnet file ! Rev o|[ Rev ] !
Copyright 2022, DYNAmore GmbH r ‘(
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POST - XYPlot

m If force is plotted against displacement, there will
now be a red point to trace the values while
animating through the simulation (when “Timeline”
option is activated). This feature is only available
when the plot is created in combination with the
result files (d3plot), such that the time-scale is
somehow available.

‘i m Import of multiple CSV data possible:

There is no unique standard for the csv header.
These input formats are supported from LS-PrePost:

Z:\Downloads\bndoutircforc

20 + ] ] | | | .
|
15 + ] A | A 1 _ | i | | | XYPlot | fSolid
S — . . I\ A -
ASCIL  GeoTol
(=] 'll,‘“,‘_w""'"“_""-u\_‘
M10 + e 5 %
Binout
Mesh
=
51 1 Follow j
— Model
0 Trace Er'lrr_}_l
g d + - : eTol
0 50 100 150 200 250 H @,_l
Z-displacement Sl |
AR
T T

/* Designed to handle three types of .csv formats
form==1. First is x-wvalue rest are y-values. At least on y-value is needed.
xvaluel, yvaluel 1, yvaluel 2, ...

xvalue2, yvaluez 1, yvalue2 2, ...

First column is always abscissa, IT a curve label is called [Tt]ime, then
it is abscissa. Otherwise ordinate

Abscissa, curvelabell, curvelabel2, [Tt]ime, ...

xvaluel, yvaluel 1, yvaluel 2, ...

xvalue2, yvaluez 1, yvalue2 2, ...

form==2.

form==3.

Window label, Ordinate

Abscissa, curvelabell, curvelabel2, [Ttlime, ...
numberl, numberl, ...

number2, numberz, ...
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® Popup| O Main SW Split
{3
Common (,,o0ld*“) curve plot manager ow || add
Clear Raise Pop
Done
m Filter option: Support for multiple curves to force to zero per SAE J211.
m Improve the history New button'’s behaviors when no XYData is ready (don't create the empty window)
m Support for “Exp to Decimal” and “No. of Digits“ :> Element History
m Output option at “Info” tab: Write in the message box 300 N
. . |
the part id or curve legend label of the curve with g 200 /N
the maximum y-value 7 0\ /
5 1501\ /
5o o ETTaTSTeTgy @z 2 N\ TN /
: Linena vy g0 || |2 5 00l \ ~~ AN /
S N — sl rem @t | 15 5 N A /
ME ig DE iﬁ B ASCII  GeoTol 50 _____—,.—-"""
°% 5 10 15 05 30 BE«E v
Tite | sale | Awr | Fieer | prine Tesm | toad [ oper [ Hide [ ciose | auie ; MjT — = 0.01 0.02 0.03 0.04 0.05 0.06
posymbol || symbot | — |+ oy | et | Fead — h:el I.m&fnsizfﬁ;"ﬂ ‘ | ‘ 'I'Ir"ne | ‘ ‘ ‘
1| Frame T "IeT; | Info Title Scale Attr Filter Print Save Load Oper Hide Close Quit
[ Join symborply Symb{  color: | W |+ M E ékﬂ:f“: H E@.l No. of Curves = 1 o
[ point symb e |= [ | e e :f"::r'i“e :@e = Total selected = 1 Points/Symbol |:| Symbol: - |- Apply ‘ Reset | ;Prck
[1Ep to Dec | J J miTy el M5 A | 2 s symisotswithpply Symbot]  cogor: " - ) t<gend
vouva[i ] sve == | we| |l = e o | | R
m chamd ) ar | point symbol Width: - - Appl Reset B -
< >| ShowAll ‘Shawsem‘ Reer‘ Apply ‘ e ‘ Done ii’fﬁi‘;’! B Favort —— e t0 Decms ly } I ZEE%Z\
ECEEEEEL L e oot D > il sty
Eﬂ'k"étﬁgﬁféﬁ'i:'guwe Legend:internal_energy @ C S ‘ e | L=l ‘ Apply ‘ b=z ‘ T3 i.ﬂveraqe
Copyright 2022, DYNAmore GmbH N A4
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,2New* 2D curve plot manager

m 2 start options for new plot manager:

Bottom toolbar icon “Plot Manage”

&

r;

“Main” option in curve selection interfaces

;

the curve also

<8

L2l
f
File View Help
x
Project
| —
E}
WA ing
i
i
i

i PDDU[[ (®) Main
Plot Mew
Clear Raise
Done

m The (new) XYPlot frame can ...

zxg

Modification of legend position

("LineColor”, "LineStyle" and "Name*)

show multiple ports of the 2d curves page by page

Cross panel for crossing plotting of curves (2D/3D)
“Template” option to save curve plot settings "

m Post

Open the 2D Graphics Viewer and plot

in the GUI main window

HYBRID lll RIGID DUMMY
Time= 74.998

26000 Global History

e 1 |Last: 2 Inc 1 Time: State: 13
w« |A4BPOP G

i 0s | 13 ]

Support for timeline on the
multiple view

Support for no graphics mode
Support for DEM pattern

post processing

Copyright 2022, DYNAmore GmbH
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Movie Output Data output

Main menu “File” =2 “Movie” Post -2 Output
m LS-Prepost 4.9 support create a movie at background. m Suppress output of the *INITIAL_xxx keyword
It is more quickly to avoid freezing main window. cards of rigid parts

Also, fps works for the new mqvie format(MP4, H264)

Format MP4/H.264 *INITIAL STRATN SHELL
Repeat 1 # gid nplane nthick

, 2585,0,0
Size Current Viewport -

ind . s# ERIEE ERENY ER3zE ERIRY ER3NZ ERSa%
Window size(WXH) 0.0,0.0,0.0,0.0,0.0,0.0

1430 X | 778 s

¥ ERIER ERINY ERIZR ERIREY ERINE ERIER

FPS: 5.5 0.0,0.0,0.0,0.0,0.0,0.0,0.0

- 2610,0,0
File Path | Browse 0.0,0.0,0.0,0.0,0.0,0.0,0.0

D:\testdata\ball_plate Q.0,0.0,0.0,0.0,0.0,0.0,0.0
File name

movie_000
\Gamma(0.5-2.0) dark-light
{ 1.0
Create Movie background

() Use Playback File

D:\testdata\bal_plate

Start Cancel
Copyright 2022, DYNAmore GmbH r ‘(
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Agenda

m LS-PrePost - The Team

m LS-PrePost - Version Overview

m Recent Developments
Pre-processing
Post-processing
Miscellaneous

m Conclusions

EM gje
Ctrom N
Time = 000010659 "4C for Ming prop,
em
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Misc.

,Double precision” version now is available
Both pre-processing input deck and post-processing result can be handled

Misc. 2Moldex3D
Mapping fiber orientation tensor, volume fraction and residual stress

Femzip file import
Improve efficiency of animation with fringing at 1st time

Support for loading 8 nodes shell model

Nodal average and non-average thickness option for beams and shells:
Settings—> Configuration 2Display 2Shell/Beam >Nodal average Thickness

=

Configuration Settings

= Environment
General
Color
Lighting

- Display
General

_SheI/Beam

#- Keyword
- Application

Shell
Thickness Reduction Mode: 1 v

IntPt: maxima v

‘ [] Thickened Shell In Animation [] Smooth Shell Appearance

[ Nodal Average Thickness

Beam

Tube Segments:
Size Factor:
Line Width: 1 v
[ Third Node

[ Reference Surface Location
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Misc.

m Add compare of d3hsp option in
Misc. 2D3hsp View

Misc, View Geometry FEM
View Medel Info
Wiew Memory Infe
View Message Info
Display Ruler
Set Keyword Title
Start Recording Commands
Launch Macro Interface
Manage Command File
Execute System Call
Keyword File Separate

I D3hsp Wiew I

MSSetup
Moldex3D
WiewFactor

Bottem Dead Center

D3hsp View

Search: |

vloo P

- C:\Users\ pierre.glay\Documents\ BACKUP_GLAY\4_SCHULWI |
:\Users\ pierre.glay\Documents\ BACKU g : o

Set as compare target

Compare to selected target

se C\.‘C\‘\"

< >

Display Refered Entity:
[ Display Entity All Mone

File Path: | C:\Users\pierre.glav\Documents\BACKUP_GLAﬂ Browse

Load Remaove

ExpandAll

Colapseal

D3View Compare ¢

<

v Solver Information

\ersion : smp s R11.1.0 Date: 08/12/2019 |
Time: 09:16:48

Rewvision: 139588
Precision : Single precision (14R4)
\ersion: 139588
Version 3 (full output)
Version 4 (full output)
Version 3 (full output)
Version 4 (full output)
Input file: ball_and_plate.k
> LIST OF KEYWORD COUNTS
> control information

|fhome/silvia.mandel/silvia/balljoriginalfmany-states/c =

e

v Solver Information
“ersion : smp d R11 Date: 06/05/2018
| Revision: 127538 Time: 13:40:46 |
| Precision : Double precision (I8R8) |
“ersion: 127538 |
wersion 3 (full output)
wersion 4 (full output)
version 3 (full output)
Wersion 4 (full output)

» LIST OF KEYWORD COUNTS
‘ - ‘ > control information

v ‘hnme‘silvia.mandel‘silvia‘hall‘nriainal‘:ﬂhsg

Input file: fhome/silvia.mandel/silviasballjoriginal/b:

<[

)] ey <[ )|

| ExpandAll || collapseAll ||  Done

)

) (%

m Binary d3lsda file in Windows version:
Support to import and export

Support to set the output
(such as compress, output variables,

threshold...)

Support binout for lsda fringe

LS-PrePost(R) V4.9 (Beta) - 1d)an:

Mastran+pch File

Lsplot File
File Misc. View Geometry FE Others N
New Selutions b
Open > — > D3lsda File
Imnnrt ¥
e X
Global_Vars Part_Vars Threshold
Output States: | Input format: 1, 2, £10:2, 2 default: all ‘
Qutput Parts: | Input format: 1, 2, 410:2, 20:50; default: all ‘
Node Variable: Elem Variables: Compression flag:
temperature stress stress -
elocity effective plastic strain effective plastic strain
[ acceleration [ strain [ strain
A heat flux [ thickness [ thickness
istory var istory var
i mx
my my
mxy mxy
A e A e hd
ALL NONE REVERSE ALL NOMNE REVERSE ALL NONE REVERSE
d3plot file: | Ci\Users\pierre.glay\Documents\BACKUP_GLAY\4_SCHULUNG\O0_ROLL_FORMING\4_PROFIL\RELEASE_6.1%DynaSimDemc\Solid\DynaSim [| Brower
Config file: ‘ ChUsers\pierre.glay\Documents\BACKUP_GLAV\A_SCHULUNG\00_ROLL_FORMING'\4_PROFIL\RELEASE_6.1"\DynaSimDema’\Solid\L5DA\co r| Brower
D3lsda file: | Ch\Users\pierre.glay\Documents\BACKUP_GLAV\4_SCHULUNG\00_ROLL_FORMING\A_PROFIL\RELEASE_6.1"DynaSimDematSelid\L5DANd3I | Brower

Write D3lsda Write Config
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Misc.

m D3plot: File->Open to load multiple sets of d3plot files simultaneously.

File Misc. View Geometry FEM Application Settings Help
<« v 4 <« BACKUP_GLAY » 4 SCHULUNG » DO_ROLL_FORMING » 4 PROFIL » RELEASE_6.0.1 » BumperS » Vol IGA v O "Vol_IGA" durchsuchen
Organisieren = Meuer Ordner == « [N o

~
[ Mame Anderungsdatum Typ Griafie

3t Schnellzugriff
| | zBumperS_F02.d3plot

@ OneDrive - Personal || zBumpers_F03.d3plot

2111:01 D3PLOT-Datei 15.592
21 11:01 D3PLOT-Datei 1

[ Dieser PC || zBumpers_FO04.d3plot D3PLOT-Datei 16.4
| | zBumperS_F05.d3plot D3PLOT-Datei 16.112 KB
g Netzwerk || zBumperS_FD6.d3plot D3IPLOT-Datei 16.112 KB
|| zBumperS_FO7.d3plot D3PLOT-Datei 15.010 KB
| | zBumperS_F0B.d3plot D3PLOT-Datei 14476 KB

|| zBumperS_F09.d3plot D3PLOT-Datei 13.968 KB
|| zBumperS_F10.d3plot D3PLOT-Datei 13.572 KB
|| zBumperS_F11.d3plot D3PLOT-Datei 13.516 KB
|| zBumperS_F12.d3plot D3PLOT-Datei 13.014 KB
| | zBumperS_F13.d3plot D3PLOT-Datei 13.1

|| zBumperS_F14.d3plot
|| zBumperS_F15.d3plot
| | zBumperS_F16.d3plot
|| zBumpers_F17.d3plot
|| zBumpers_F18.d3plot
| | zBumperS_F19.d3plot
|1 zBumperS F20.d3plot

D3PLOT-Datei
D3PLOT-Datei
D3PLOT-Datei
D3PLOT-Datei
D3PLOT-Datei
D3PLOT-Datei
D3PLOT-Datei

1
]
1
]
]
1
]
1

Dateiname: |"zBumperS_FDS.d3plot" "zBumperS_FOB.d3plot" "zBumperS_FO7.d3plot” "zBumperS_F08.d3plot” "zBumperS_F0S.d3plot" "zBur v| Binary Plot(*d?plot*,"d?thdt", i1 ~

Offnen Abbrechen

m Interesting functions for multiple d3plot import:

Chaining the models to one model view: iJ > Cﬁd

Split option for the main window to show multiple d3plot models:

Window Configuration

Post Splitin
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“Diff Parts” option in compare function of keywords models

m Model > MSelect (Model Selection) | summayinor conmansemorss oseiion s || Osela _
odel odel ifference iff y = ol
- Compare: Diff Parts View - e e | % 1
. . . um. Beam Elems |28 28 0 0
Diff Parts option available to color | wmamisom woe  swe s o | & vV
parts with differences between the | tumuesten: | ; ; (@) Keyword fenrd - cune
two compare models. Num. shell Parts |15 15 0 0 el oo Cr;En't ﬁ:
. . Model Extent X 646.238 646.238 0 0 [ I |
Parts are automatically saved in ModelExtenty  [168111 168111 [0 : —— : & Q
. | ompare | 5
the LS-PrePost selection buffer B—-oo pem ¢ : rypes[suress . . g
- Follow-on processes with these Correlation Cof = pre— 0 oy Gt
. Ry
detected parts are possible o ) @
R
| rringe it | :ml ”E%
(D00l Rin:m h:zfjial
I [ Diff Parts [+ M1 || M2IWriteSummar}r” WriteDetail ||  Done H"‘J/ :':'fl
'5353‘" EleTol
;| &
MSelect -
ok
Subsys Ms
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Subsystem Manager

m Support multiply models on “Subsystem Manager” subsystem Manager
. | ¢
dialog and copy keyword between models L e Refchk ;‘%
Search: | v‘ OO > B =
" P
:> v [1] DynaSimDemo_u_Ger3.dyn (C:\Users\pierre.glay\Docume s;;tn E;’:j;'
#{¥ [2] - Roll Forming DynaSimDemo_u Ger3 o5 =
MSelect F:)st]
< > &ﬁ‘ Ms
[]Select parts and move to selected subsystem Apply %i MS'
[[IMove part properties together with part Goups  Op
Set Active
Note:
« 1. To Set Active/Inactive : Click the Check Box on the tree,
adjacent to the Subsystem/Part title
. 2. To Write Subsystem : Click on Subsystem title to highlight
m The so-called “Subsystems” in LS-PrePost means it and then cick Write
the separate keyword files which are used in a @® By Subsystem (O By Part
LS-DYNA keyword model by using the *INCLUDE Al None Reverse
keyword.
Write Close
Copyright 2022, DYNA GmbH r N
\n sys LST All rights reserved. Non-commercial usage is granted if credits are given clearly to DYNAmore GmbH and copyrig?m[iyrgiwarks are not br;]?;emovmed. D N A

41 MIORE



Change background colors

m Legends and Title get some background colors (backdrop) [ewrr  ammwms =
for better visualization S

This feature can be activated by: Settings 2>Configuration e | o
Settings 2Display >Test backdrop ot [ Make "Pick Center”ndependent of "uto Center
The background colors can be changed by using following T o™ Boeae g
command backdropcolor R G B A where the parameters oot pove o, g AL . o ot ok
[R]ed [G]reen [B]lue and [A]lpha can have values from 0. to =
1. Alpha=0.0 is fully transparent. The default values are FIe0 foret  Dgtsmurber| 1]
[0.8 0.8 0.8 0.8] e :

Write Config || Reset Config Cancel 0Ok

Time = 0 Effective Stress (v-m)

= 0 Effective Stress (v-m)

ﬁ‘;’;‘:’: rvsa?JEEffective Stress (v-m) - - 400 _I Contours of Effective Stress (v-m) - 400

min=0, at elem# 1700641 N 361 _ (i o e h N S ]

max=506.57, at elemi# 10000008 i 322 _ mMax=596.57, at elem# 10000008 k \ 322
Post ".‘ 283 _ mPast | 283
; 244 _ J 244 _
/,f' 205 _ :{> : j 205
gt 166 _ i 166 _
127 _ ‘i.\ 127 _

88 \ -

!\ o .“!
J 49 ] 1 49
p 10_ // 10
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Measure Separation Geometry

GeoTol (Geometry Tools) > Measure L

Measur

m Measure Separation of Faces-to-Faces

LS-DYNA keyword deck by LS-PrePo -
"_‘", F'lsd:.:;(.‘u')u_::vu_oun_nuj.c. D;"
m Shell 1 Sark

F B B Spline Face 653 &

-/ Shell 2 ExtCur

la}

I~
{95 1rinfals lRten ks

ExtFace

Measure Faces Min Dstance o
Inter

Ostc @Des | Preview
'

LS-PrePast(R) V4.8.25 - 041an2022-64bit nar- TUDRESDEN-25022020\example-show Simulation_S-Raild3plot

- o x
o File Misc. View Geometry FEM Application Settings Help
Offoet
e o LS-DYNA keyword deck by LS-PrePost #y [
M);a Time = 0.02, #nodes=7826, #elem=7463 Part to Surface Separation Z-axial Distance Ident RefGeo
¥ Contours of Part to Surface Separation Z-axial Distance 40.19 ﬁ U
& Closest Node=5653 to Surface, Distance=-0.9154 7 Fnd  Curve
hewinr min=-0.319332, at node# 12051 36.14 | &
> |, Max=40.1884, at node# 7823 32,09 S~
Stitch .
e CmPost : 28.04 _ &
[/an} m 1Matrize sesare - 23.90 MovCop  Solid
Trm W 2 Stempel - : e !
2 m 3 Blechhalter Item: | Dist Part to Surf
Cose || Export... = ', 4 Platine Active Elements Only 19.93 _ Offset GeaTal
o 7 Assembly 1 - Arbag Node RG 15.88 I '
I 6.98990+01 - 7 ShapeGroup Elem () Part (Al (iSeg (Nd ] iy
6.5171e401 Rever m Planar Face 1 = | 11.83 Mesh
o Reference Axes: Delete 4> ca
Global o

frifure
“4i 4
F

i ?Zn?i.;ﬁé‘?

3% G 04 24 7

Cancel Pick | | Apply

Report

9990 . YU T yrEFOEQC T X 9E

art Separation
OPick Part @ Pick Surface
| Axial

Components or Axis

Oax OAY @Az
@+ Ove O+ve
Shell thickness offset

T T

X

m LS-PrePost offers many different kind of separation
. Dlagen Fise 1]t 22]ine]_1 et 0020003 s 22] -
measure tools, for example in EleTol>Measure oo IR e

>”Separation” or “Dist Part/Node to Surface”: Lefeevorseds . Buaty

>

Show Tracer Plot

@oed -~ XwEaHE

UALRGIOUNG LU 1.U 1.0, (EA
|till|§talllv,uobr 0.0 0.0 0.0;

Distance between parts in positive and negative directions
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Misc.

m Unicode is supported and needed by most platform
Without Unicode, some Unicode characters and Unicode

path or model name couldn’t be loaded correctly Ao aan
m  Compile with GTK3 on Linux H <
LS-Prepost 4.9 now is built in a special GTK3 version too. A f
|:<I>0>| -,g. ::
m AUl framework (Currently only in special version 4.9) s s
New GUI are created with AUl framework. Toolbars and v
panels could move and float and dock.
The new framework makes the development more
convenient and flexible, more compatible with o
wxWidgets.
Many nice options to modify your GUI toolbar are possible in Settings - Toolbar Manager (e.g. user
macro script as a separate icon, delete unnecessary default icons, move icons from right toolbar to
bottom toolbar ,... )
C right 2022, DYNAmore GmbH
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VIEW - MSPost Explorer (ICFD post processing module)

m Functions of the ,,MSPost Explorer are continuously in an extension/optimization process. Following
main functions are available: Section Plane, ISO Surface, Stream Line, Vector Plot, Fringe Level Set,

Data Extraction, Line Integral Convolution(LIC), Attached/Separated Line, Vertex Core

LS-PrePost(R) V4.0 (Beta) - 141an2022

File Misc. View Geometry FEM  Application Settings Help

Full Screen (Esc to Exit)

Background
Geometry Shade
Element Shade

~ Al Elements

~ Al Geometry
Ref Geometry

~ Points
Curves

~  Surfaces

Grid
Toolbar

Local Element Axes
~  Beam Prism

Beam Prism Fast

Smoaoth Fringe Color

Keep Zout Orientation

Show Deleted Nodes

Show Deleted Elements

Show Deleted Elements Only

Ignore Deleted Elements Flag
~  Results On Screen

Smooth Shade

Record Message

Show Mid-Side Nodes

A Axis Orientation Only

Ne Coord. Update

Solution Explorer
Subset Explorer
Report Explorer
Post Explorer
MSPost Explorer

Ctrl+Shift+T
Ctrl+Shift+R
Ctrl+Shift+P

>

>

»

File Misc. View Geometry FEM Application Settings Help

MSPost Explorer

Objects
v W[ Model
¥ [[%] MS_SHELL_GROUP
¥ ¥+ cfd_bdry_0001_1
[ty VectPlot 13
[« cfd_bdry_0002.7
(<% cfd_bdry_0003_10
¥ [ cfd_bdry_ 000411
[, VectPlot_14
¥ [ cfd_bdry 0005 22
(1, VectPlot_15
¥ [¥]<> cfd_bdry_0006_33
[T, vectPlot_16
¥ ¥ cfd_bdry_0007_44
1y VectPlot_17
¥ [¥I[5 Ms_SOLID_GROUP
¥ [W)I3 MS_SOLID_8

v DeESlR
All None Reverse

LS-PrePost(R) V4.9 (Beta) - 07Feb2022-64hit andel/Downloads/Auswertung_CFD-Only_02-nod3plot.cfile/d3plot

Object Properties | Display Options

Mode Shade
Transparency 0
¥ Fringe
Colar by PID
PID Color W o462
Component Maghitude
ringe Level )
in Scalar
calar )
calar 0
p Min/ O
Global Wir
¥ Line
Line widtt
MsPost X

Increase or decrease animation speed

Chl
mmPost

m}ea miine_20

Nrmx

NrmY

= iy} F b
+ + + + + + +

P : & & & 2 & B
] | | 1 1 ! |
I

TO+2000°L
T0+2000°8

VectPlot_17
Fluid velocity
1.000e+02

9.000e+01 ]

8.000e+01 _|
7.000e+01 _
6.000e+01 _
5.000e+01 _
4.000e+01 |
3.000e+01 _
2.000e+01

1.DDDE+DII
0.000e+00

s|nc:| 1 |Time:

<< 0> (>

Z0+8000°T

w
g
-]
H
B Fluid velocity

5 8 g 9 & @ © @ @8 8 @ % U
Option  HidEle | Shable | VieEle WirEle Feat Edge  Grid | Mesh | Shrink SectMo Fringe Unref
>

Jicfd select 11

» FH E »

ShfCtr  Clear AutCen  Zoln

-+ x

= 0

MS-Ascii  RefGeo

o

Lso Curve
Hh <
Ident Surf
S
Find Solid

-

Measur  GeoTol

Msprd
e,
:

Favor1

Fast Renderer

Courtesy of BioCardioLab, Italy.
http://bcl.ftgm.it/

\NSysS LsT
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Agenda

m LS-PrePost - The Team

m LS-PrePost - Version Overview

m Recent Developments
Pre-processing
Post-processing
Miscellaneous

m Conclusions
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Conclusions

m LS-PrePost has been keeping up with the rapid development of LS-DYNA. LS-PrePost supported the post-
processing of results and the pre-processing of input keyword setup for all kinds of LS-DYNA applications
(Structure, Thermal, ICFD, ALE, EM,..).

m A main focus of the developers is to provide tools to make it more user friendly and intuitive. Many
features and capabilities were implemented based on users’ requests and suggestions.

m DYNAmore works directly together with the LS-PrePost developers and customer requests can be
discussed very fast with the LS-PrePost developer team.

m DYNAmore and the LS-PrePost developers would like to support our customers by improving and speed
up their pre- and post-processes for the LS-DYNA simulations.

m The DYNAmore LS-PrePost support team and the whole team of LS-PrePost developers are open to advice
and happy to listen to our customers for their needs.

m Meet Dynamore and developers at the Dynamore conferences. The 16th German LS-DYNA Forum will
take place from October 11-13, 2022 in Bamberg and online. The forum is the main event dedicated to
LS-DYNA in Central Europe.

- ort tWW“'M
B%tQD ,,wfwé:mfe/ Ls-prepost S4PP (¢
Yow Y

0.. NA
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Thank you for your attention!

For the slides, check out
https://www.dynamore.de/en/downloads/infodays
and our YouTube-Channel for the session recordings.

If you have questions, feel free to contact us at support@dynamore.de
or take a look at

m LS-DYNA examples (www.dynaexamples.com)

m Papers/Conference proceedings (www.dynalook.com)
m Hints, FAQ,... (www.dynasupport.com)

m Manuals (http://lstc.com/download/manuals)

No part of this broadcast may be reproduced, distributed, or transmitted in any form or by
any means, including photocopying, recording, or other electronic or mechanical methods.
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